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C. Layers Photoshop Scrapbook

CC 2017

Layers can be thought of as sheets that sit on top of each other. The bottom layer of an image in Photoshop is the background. We
can add a picture in a new layer above the background and then add some effects in yet another layer above this.

In the example below, we have a background, a photo and a mask all in separate layers. The mask is used to hide sections of the
photo below. The fact that we have used layers means that we can:

a. Change the background at any time without affecting the photo or the effects used;
b. Replace or transform the photo if we wish;

c. Change what is visible by editing the mask in the top layer.

When the Photoshop file is saved, all the layer information is remembered so that you can continue to make changes later.
However, when you create your output file, Photoshop merges all the different information into a single flat image that is a
combination of all the different layers. If you are not satisfied with the output image, you can return to the Photoshop file,
continue to make changes and then save a new output.

In our example, the combination of the three layers on the left leads to the output shown on the right.

Photo o
Final Output
Background
Looking at the Layers
So far, we have placed a single picture on our scrapbook page. If you —_— -
look in the lower-right of the screen, you should see the Layers panel. £ Kind m=e@Tnga®*
We currently have two layers, the white background and the photo in | Hormal v| Opaciy: | 100% | |

Layer 1. - 1008 ||
lock B b DX @ Ak 100% [

Note: Ifthe panels are not visible on the right, select ] N
‘Window / Workspace / Reset Essentials’. - _
@ D Background &
a. Click on the eyes to the left of the layer -
names to hide each layer in turn. When
nothing is visible, Photoshop shows a I—
grey chequered background. Click on
the eyes to show each layer again.

b. Double-click on the name ‘Layer 1’ and change it to something that ocki BB o b 1N @ Al 100% o
describes the photo it contains. Ours is called “Cat Photo”. —

:
Note: When you paste an image into your scrapbook, by default it will |

be placed in a new layer. There are times, however, when you ® D Background a
may want to add an image to a layer that already exists. :
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F. Backgrounds

Digital scrapbooks look great when the images are arranged on a colourful background. The background
can include colour, text, clipart and other graphics. You could also find a background on the internet

that you would like to use, although it will be good practice to try and design your own. In this task, you
will try various backgrounds and then decide on the one that you like the best. Remember that you can

change the background again at any time.

Photoshop Scrapbook

CC 2017

a.

a.

b.

Plain Coloured Background

Click on the eye icons in the Layers panel to hide all the layers except the background. You should be left with a plain
white page. Select the Background layer so that you can make changes to it.

Make sure that nothing is selected on your page (i.e. there are no marching ants). If there is a selected area, the tools

will only affect this section of the image.

Note: If a selection is in place then select any marquee tool from the toolbar and click outside the page.

Select a colour using the Color panel. You can pick the colour using
the bar on the right, then a hue from the main area.

Note: If a different set of options
is showing, click on the

small menu icon in the top- .I—-;u et
right of the Color panel and q
select the ‘Hue Cube”’. - Brightness Cifhe

Activate the Paint Bucket Tool in the toolbar (the Gradient Tool or the 3D

Material Drop Tool may be on display, in which case use the pop out menu).

Click on the screen to fill it with colour.

Gradient Tool

Plain backgrounds are fine, but you may prefer to use something a little more interesting.

Use the Fill Tools pop out menu to select the Gradient Tool.
Draw a line on the screen and look at the result.

Try drawing short and long lines in all directions. Try some other
colours, dark and light.

If you like, you can make a set of different gradients on your page
by selecting different areas with the Rectangular Marquee Tool and
then filling them with the Gradient Tool.

Save your scrapbook.

Note: It’s best not to design anything too crazy as this will distract from the

important content on the page. It’s fun to play with ideas though.
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L. Greyscale

Photoshop Scrapbook

There are many reasons why a colour photograph may need to be converted to black and white.

Black and white images tend to stand out more, especially if they are placed amongst lots of

colour. Most of the ‘black and white’ photographs used in digital design are actually greyscale;

they contain many shades of grey rather than only black and white. Newspapers traditionally use

a lot of greyscale images because they are cheaper to print. In the tasks below, we will explore
different ways of converting colour images to greyscale.

CC 2017

a.

a.

b.

Greyscale

The greyscale tool does quite a good job of
converting a colour picture. In most cases, you
may decide that this is enough.

Open a photograph that you think would look
good in greyscale. You can’t work in your
scrapbook at this point as the whole file is
converted to greyscale.

Select ‘Image / Mode / Grayscale’ from the
main menu.

Click OK to discard the colour information.

Leave the image in place for now so that you
can try the next method.

Background Overlay

Using the final greyscale image from the previous method, select ‘Layer / Duplicate Layer’ from the main menu (or right
click on the layer in the Layers panel and select Duplicate Layer). Name the new layer “Background Overlay”.

Select Overlay from the Layer Styles (in the Layers panel) and set the Opacity to 60%.

Use the eye icon to hide and show the top layer and decide whether you prefer the new version. Test different

opacities until you have your preferred result.

The image should be flattened before copying it into your scrapbook or you will only copy one layer. Select ‘Layer /
Flatten Image’ from the main menu. Notice that you now only have one layer again, called ‘Background’.

Copy your image across to your scrapbook and save your Photoshop file.

Lock:

L&)

s
o .T Background

We can go a step further with this and produce a picture with deeper shadows and more contrast.

B % h

G 4
(=]

1 ®

-
-

Background Overlay

ORB Education Quality Teaching Resources — Free Sample Materials

‘ © ORB Education Visit http://www.orbeducation.com for the full, editable versions.

CoP036 — Photoshop Scrapboo&




N. Liquify and other Filters Photoshop Scrapbook
CC 2017

Filters change the appearance of images. Examples of the filters available in Photoshop include tiling
effects, lighting, 3-dimensional effects and distortions. Some filters can be used to clean up or retouch
photographs.

In the first task below, we will investigate the Liquify Tool. You will then have the opportunity to try
some of the other weird and wonderful effects available through the Filter menu.

Liquify
Liquify (Pageboy.jpg @ 100%)
a. Open a photograph to work with. Warp
b. Select ‘Filter / Liquify’ to open the liquify tools. g Reconstruct
Vol
c. Click on the Forward Warp Tool in the D Forvard warp Tool (W) | Smooth (CC)
toolbar on the left. Twirl
d. Inthe Brush Tool Options on the right, find a size which results in Pucker
you only warping a small part of the image (hold the mouse over Bloat
the image and look at the size of the circle to get an idea).
Push
!_ Properties Freeze
¥ EBrush Tool Opbions Thaw
Sions 35 Dansity: E Hand
Pressure: . B - Zoom

e. Have a go at warping your photograph. We have used some straight hair in our example so that you can easily see the
effects.

f.  Hold down the Alt key to reverse the effect over warped sections of your image.

Note: You can’t access the ‘Undo’ and ‘Step Backward’ tools in the Edit menu whilst the Liquify window is open, but
you should be able to use the shortcuts ‘Ctrl/Cmd + Z’ and ‘Ctrl/Cmd + Alt/Option + Z'.

RY i

g. Choose the Twirl Clockwise tool and have a go at twirling part of your photo by holding your mouse down on the
image. Again, you can experiment with the different settings until you get an effect that you like.

h. Hold down the Alt key and use your mouse to twirl anticlockwise.
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0. Colourise Photoshop Scrapbook

CC 2017

The eraser is a very handy tool. As well as removing backgrounds, it can also be used to colour
a single object in a black and white photograph. This highlighting effect is quite popular with
graphic designers. It is frequently used in advertising.

Colourising

a. Find an image that you think will look good in greyscale apart from a single coloured object. This could be a flower,
balloon or car etc.

b. Create a copy of the background layer by selecting ‘Layer >
Duplicate Layer’. Alternatively, you may drag the background layer
onto the Create a new Layer icon at the bottom of the Layers panel.

c. Click on the new layer to make it active and remove the
colour using ‘Image / Adjustments / Black and White’. Click | D Kind vimeTnoa®
OK. '

T 30

lcki B f & D8 @ Al 100% v

d. Select the Eraser Tool from the toolbar.

e. Inthe tool options along the top, set the Opacity to ‘100%’.

I (t\..l : ~ 'm(wﬁ v | opm:@ | Fh'l:t_IM|v| (¢4 |1:TE|'u'lttiHih'r. @

f.  You will need to brush over your chosen object to give it A~ ,.IJ [ Moder | Brush ~| Opaciy:
colour (in actual fact, you will be erasing the black and white
layer to let the colour through from the background). You = Sie: .
should use a small brush for the edges (try 15 pixels) and T
select a larger one for the main body of the object. The size e '!% a
can be set using the control in the top toolbar. . - B [m

g. Start erasing the black and white layer.
The colour from the original background
layer will be gradually revealed.
Remember to save time by choosing a
larger brush for the bulk of the work.

h.  When you are satisfied with the result,
click ‘Layer / Flatten Image’ and copy the
final photo to your scrapbook pages.
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S. Cloning Photoshop Scrapbook

CC 2017

It is sometimes desirable to remove unwanted objects from an image. Maybe a finger partially
covered the camera lens when the picture was taken, or a speedboat spoiled the perfect shot
of a lake. The clone tool essentially copies a small section of the photograph and allows you to
paste it in the area you wish to cover.

In our example, we will remove a man walking on a beach from a photograph of someone
fishing. You can try and remove anything from one of your photos. Blemishes and shadows are
commonly removed, but you could try something startling like removing your nose from a
portrait (this would really make it obvious that you have learnt the art of cloning).

Cloning

a. Find an image with something that you would like to remove. It really can be
anything — we’re just practicing skills.

b. Select the Clone Stamp Tool from the
toolbar.

d. You are now ready to start the process of cloning small areas of the photograph. The method is to select a patch of
the photograph to copy, then paste this over the object that you would like to hide.

To copy a small sample

Hold down the Alt key and click the left mouse button on the section
of image you would like to copy. Choose an area close to the object
that you would like to hide. The tool is now ready to paste
repeatedly in the area alongside.

To paste the sample

Release the Alt key and click a few times on the object you are hiding. Remember
that you can always undo changes (use ‘Ctrl/Cmd + Alt/Option + Z’ for speed).

Instead of clicking, try using a series of short pushes. You may also increase
the size of the stamp.

Note: Something strange happens if you try and paste too far away from
the spot where the sample was taken. The Aligned feature grabs a
new sample with each push, each one the same distance away as
the first. Feel free to investigate the effect of unchecking the Aligned
box and sampling a patch again. This time, the exact patch can be
reproduced anywhere in the photo. The easiest way to understand
all this is to test it.

e. Continue to pick up colour and paste it until you start to get a result that you are happy
with. When you are ready, copy the image to your scrapbook.
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Appendix 4. Size vs Quality Photoshop Scrapbook
CC 2017

As suggested previously, images are sometimes resized because of a restricted amount of available storage space. Detailed
images with large file sizes also increase the amount of processing required to display the picture on a screen. In this task, we look
at how to reduce the file size whilst maintaining the physical size of the picture. This method is useful when creating images for
full-screen display e.g. for slide presentations, where a slight loss of quality is not evident. It is generally not appropriate for
images that you intend to print.

Creating a Test Pattern E B 2B BN
Start by creating a test pattern with some coloured shapes on a white " N I
background. The one shown on the right is a good example, made as follows: HE B2 B E N

a. Click ‘File / New’ and create a new file with a custom size of 200px by 200px "N . BN

and a white background.
b. Select the Rectangle Tool from the toolbar and click on the screen. Create a square that is 10px by 10px of any colour.
c.  Click ‘Layer / Flatten Image’ and use the Magic Wand Tool to select your square.

d. Use ‘Ctrl/Cmd + C’ to copy the square and ‘Ctrl/Cmd + V’ to paste a copy
(it will appear over the top of the first).

e. Select the Move Tool and drag the new copy to the right of the first.
Continue pasting and moving until you have a group of coloured squares.
Each square will be in its own layer.

f.  Flatten the image again and use the Paint Bucket Tool to fill the squares with a variety of colours.

Saving Your Image

a. Select ‘File / Export As’, set the format as JPG and leave the quality at 100%.

il Test Quality 100
Click Export All and name the copy ‘Test Quality 100.jpg’. Eflename Quality

Save as type: | JPG (".jpg)

b. Export the image again, this time with a Quality of ‘0’ and the name
‘Test Quality 0.jpg’.

c. Lookinyourimages folder and find the size of this file. Ours are shown below.

| Test Quality 0.jpg 25/08/2017 3:31PM  JPG File 6 KB
| Test Quality 100,jpg 25/09/2017 %29 PM  JPG File 21 KB

d. Open the JPEG files in whatever image viewer you
have on your device (or just use Photoshop) and

zoom in close. E B S EEN JPEG Option:
b= . ] . Matte:  None
On this occasion, we have reduced the file size b Image Options
. . . Y EEEEREN

lowering the quality rather than reducing the size Quality: | Low vl
of the image. The loss of quality is usually far less = BN sl Fle arge file
noticeable in photographs unless they are viewed '
on a large screen or printed professionally.

Ghosts?
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